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Session Outline


•  Part I: Writing for Today’s Readers
•  Part 2: Starting Your Document
•  Part 3: Writing
•  Part 4: Finishing Your Document



Learning Objectives


•  Write for how people read today
•  Use a proven technique to organize 
ideas and research

•  Apply plain language principles for 
maximum impact

•  Condense text
•  Communicate in clearly and concisely
•  Write persuasively
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Writing	for	Today’s	
Readers		

Part	1	



Communicating today
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How do people read today?


•  They don’t — they skim















Simplicity is the ultimate sophistication. 
	

	 	 	 	 	-	Leonardo	da	Vinci	







con•cise: adjective (of speech, 
writing, style, or a person) brief, 
but comprehensive in expression 







www.apartmenttherapy.com 



Clear 







Our sales associates are 
encouraged to check out the 
customers in the aisles. 



Correct








 




The procedure is actually quite simple. 
First, you arrange things into different 
groups depending on their makeup. One 
pile may be sufficient depending on how 
much there is. If you have to go some-
where else due to lack of facilities, 
that’s the next step; otherwise you’re 
pretty well set. It is important not to 
overdue any particular endeavour: it’s 
better to do too few at once than too 
many. In the short run, this may not 
seem important, but complications can 
arise from doing too things at once.
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Laundry Instructions


The procedure is actually quite simple. 
First, you arrange things into different 
groups depending on their makeup. One 
pile may be sufficient depending on how 
much there is. If you have to go some-
where else due to lack of facilities, that’s 
the next step; otherwise you’re pretty well 
set. It is important not to overdo any 
particular endeavour: it’s better to do too 
few at once than too many. In the short 
run, this may not seem important, but 
complications can arise from doing too 
many things at once.
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The	form	in	which	thoughts	occur	to	a	writer		
is	rarely	the	same	as	the	form	in	which		
readers	can	absorb	them.		



Consistent	



Consistency matters today


•  procedure
•  process
•  technique
•  system



•  Cabin
•  Cottage
•  Camp
•  Chalet 



The Writer-Reader Loop






The Writer-Reader Loop




Best way to 
communicate?


•  Incorporate plain language techniques



Starting	Your	Document	

Part	2	



Step-by-step approach




The Beginning:
1.  Planning
2. Outlining 



3. The Work — Writing



4 & 5: The End — Revising & Editing



1. Planning





•  Know your reader
•  Establish an appropriate tone
•  Determine the document’s purpose and 
impact



Know Your Reader!




Identify what your reader needs 
to know — and why




•  How complex is this subject
•  What are its political ramifications?
•  How close are my readers to this 
subject?



Think about the purpose!


•  My purpose in writing this is to 
_________________ _______________(my 

reader) __________________________ so

that he/she will do/think_______________.





Know your reader!




Tools to help gauge readability


In Word: 
•  Tools → Spelling & Grammar → 
Options → Show readability statistics

•  File → Proofread → Spelling & 
Grammar → Options → Show 
readability statistics 

Or
•  Hemingway App 
(www.hemingwayapp.com)







Tone	
matters	
What	are	some	of	the	

different	tones	you	might	
take	in	your	writing?	



Appropriate tone for colleagues


•  Collaborative
•  Information exchange
•  Operational support
•  Cooperative



Tone with clients and the public


•  Avoid technical terms and jargon



Document Purpose




Document Purposes


•  Provide a record of decisions
•  Plan a way forward
•  Report on discussions
•  Ask someone to do something
•  Inform your readers
•  Respond to an RFP
•  Influence actions
•  Explain how to do something



Sell your ideas
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•  Think before you start to write. Start 
from the end point: what do you want 
your reader to take away?



Step 2
 •  Outline Your Document



Organizing information


WHAT?	 SO	WHAT?	 NOW	WHAT?	



Organize	
Your	
Information	



Organize information


Design a document so that readers find 
information in the order in which they 
need to know:
•  What?
•  So what?
•  Now what?



Help your reader find information




Exercise: pages 12–13




Writing	

Part	3	



3. The Work — Writing





Paragraphs	 3.1	



Paragraph = one coherent 
thought




Paragraphs


•  A paragraph should contain one main 
idea. 

•  A document can be structured 
effectively using topic sentences.





Topic sentence exercise 1




Unify paragraphs


Unity	of	
thought	

Unity	of	tone	 United	point	of	
view	



Paragraph Unity, p. 18: Where 
does unity fall apart? What rules 

are broken?




Connecting ideas


•  Repeat key words
•  Use pronouns
•  Use connecting words and phrases



Repeat key words




Use pronouns


Many students 
are no longer 
learning 
cursive 
writing. That is 
a shame.	



Use connecting 
words & phrases




Sentences	
	

3.2	



Sentence	
length?	
	
	
	
•  80?	



1500s


50



Today?






Ways to 
shorten 

sentences


Divide	the	sentence	
into	smaller	
sentences	

Use	bullets	

Unpack	embedded	
ideas	







Remember!

Vary sentence length to increase 
readability:
•  Many Canadians see the CPP as a safety 
net. They rely on it to provide additional 
income in retirement. Others do not 
agree with them and save for themselves.

•  Many Canadians see the CPP as a safety 
net, relying on it to provide additional 
income for their retirement years. But 
others disagree.



Bullets

In case of fire, notify the switchboard of 
the fire’s location, leave the building 
immediately, using the stairs—do not use 
the elevators or you will end up trapped 
between floors if electrical power is cut off, 
either by the fire or as a safety measure, 
while the unobstructed vertical shaft 
attracts heat and smoke like a natural 
chimney—direct the spray from fire hoses 
at the base of the flame, but do not 
return to the building until instructed to do 
so. 



Or…


In case of fire:
•  Leave the building immediately
•  Use the stairs, not the elevator
•  Call the fire department
•  Stay outside until instructed to return 



Bulleted list exercise, p. 23 & 24
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This technology’s graphical interface 
helps you determine:
•  the activities in your process
•  the resources you need
•  the logical order of your activities
•  the conditions you require for the next 
activity to begin.
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•  Protect
•  Target
•  Respond… with greater efficiency and 
agility

•  Embrace
•  Support
•  Protect



The original 2014 audit found that the 
City could save up to $106,00 by
•  developing policies and procedures to 
govern the use of City vehicles, 
parking passes, and car allowances

•  implementing better controls over the 
use of City vehicles and mileage 
claims

•  tracking and documenting these 
controls and costs



Unpack 
embedded 

ideas


Embedded ideas are buried within 
sentences. Take the following steps 
to unpack them:
•  Break the sentence into distinct 

ideas.
•  Look for the main clause and 

subordinate clauses. 
•  Rearrange the sentences in a 

logical manner.



Embedded ideas


•  Exercise, pages 26–27



PSC and TBS collect the information you 
provide for three purposes:
•  to confirm the eligibility of your 
appointment

•  to safeguard the integrity of the 
appointment

•  to allow for statistical studies, which 
are published annually



The FBI and Justice Department 
reviewed criminal cases from the FBI lab 
dating back to 2012. This investigation 
found flawed forensic testimony in 
almost every case. 



Use prepositional phrases wisely


•  Extra prepositional phrases can 
confuse the reader.

•  Order them carefully.



Prepositions


•  A linking word that often introduces 
an adjective or adverbial phrase

•  Prepositions are always in 
prepositional phrases

•  Include above, after, around, at, 
before, beside, by, during, for, from, 
in, of, on, over, up to, with



•  The bike path beside the canal was 
finally resurfaced from Fifth Avenue to 
Pretoria Bridge.

•  She walked down the garden path.
•  The cake with the beautiful pink icing 
fell onto the wooden floor.



Exercise 


•  Identify and underline the prepositional 
phrases at the bottom of page 28.

•  What’s left?



Prepositional Phrases


•  In Canada, the process of extradition 
is initiated by an incoming request on 
behalf of a foreign state or tribunal 
for the arrest of a fugitive currently 
located on Canadian territory. 

•  The snow plow on our street at night  
woke up everyone in our family by 
circling the boulevard in front of our 
house at 3 a.m. with its lights blinking.



•  Many houses in the northern 
community of Ft. McMurray were 
destroyed by a raging wildfire in May 
2016. 

•  Police across the country were out on 
the long weekend looking for drug- 
and alcohol-impaired drivers on the 
country’s roads. 

•  NYEW provides a unique opportunity 
for Grade 12 students from across 
Canada to experience what it’s like to 
be a cadet in training at RCMP Depot 
for seven days in March 2019. 



Words	 3.3	



Communicate effectively


•  Use simple, everyday words
•  Understand hierarchies of abstraction
•  Use the active voice
•  Use positive statements
•  Activate your verbs
•  Avoid noun strings
•  Remove expletives
•  Cut out unnecessary words



The writer who breeds more words than 
he needs is making a chore for the readers 

who read.



Exercise	
Page	29	



Concrete èAbstract

•  rust 
•  rot 
•  decay 
•  end
•  die

•  deterioration
•  decline
•  age

•  finiteness
•  mortality
•  entropy
•  impermanence 



Active voice


Doer doing doee/what

The committee  approved the 
changes. 



Passive voice


(Doee/what) having something done  
(by the doer) 

The changes were approved by the 
committee. 



•  The committee approved the changes.
•  The changes were approved by the 
committee.

•  The dog bit the man.
•  The man was bitten by the dog.



Change these passives into the 
active voice


•  Next week, all tenders for the new facility will 
be reviewed by the committee.

•  The fact that she had signed a contract was 
ignored by the complainant.

•  The cookie was given to me by Mommy.

•  Mistakes were made.



When to use passive voice


•  When giving no attribution
•  To be vague
•  When action is more important than 
the actor

•  Some web headings



Active voice exercise: p. 31






Use positive statements


•  The procedure will not be ineffective.
•  She did not think that studying Latin 
was a sensible way to use one’s time. 
(Strunk and White)

•  The CDC study doesn’t say that the 
vaccine didn’t work.
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Activate 
your 

verbs!


Noun + active verb = energy
•  The candidate argued that his 

party could best create jobs.

Noun + equating verb or linking 
verb + noun = ho-hum
•  The candidate’s argument is that 

his party could best create jobs



Activate your verbs


•  There is therefore an expectation on 
the part of the complainant that the 
dispute will be resolved in her favour.

•  The committee made a resolution that 
a study be carried out by the board 
into the feasibility of the provision of 
plain language contracts by the 
telecommunications service providers.



Killer “B”s

is 
am 

are 

 

 

be 

been 

being 

 
 

was 

were 

 

 

to be 
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Energy Levels

•  Energy Level 1 (high): Active transitive 
verbs

•  Energy Level 2 (OK): Active intransitive 
verbs

•  Energy Level 3 (weak): Passive verb

•  Energy Level 4 (snore): Equating verbs 



Energy Level 1


High: Active transitive verbs

Doer è doing è doee

The dog bites the man.
The tornado hit the house.

3 out of 3: 100% 



Energy Level 2


Moderate: Active intransitive verb

Doer è doing 

The dog bites.
The tornado hit.

2 out of 3: 70%



Energy Level 3

Low: passive verb

Doeeè has something done è doer

The man was bitten by the dog.
The house was hit by the tornado.

Weakest 2 out of 3 and in reverse order: 
50%



Energy Level 4

Very low: equating verb

No doer, no doee, but some action.
A=B

The man is angry.
The dog is a biter.

The house is a mess.
The tornado was big.

0 out of 3: less than 25%



Watch out for…


•  ment
•  tion
•  ance
•  ence
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Active verb exercise


•  Page 34



Avoid noun chains


•  In	English,	nouns	can	be	used	to	modify	other	
nouns	

•  Noun	clumps	make	readers	go	back	to	see	
what	is	being	modified	

•  Noun	clumps	are	harder	to	decode	
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•  Green fleet plan management

136	

A	plan	

to	manage	

	a	fleet	

that's	
green	



•  Trade agreement disclosure obligation

137	

an	obligation	

to	disclose	
(something)	

that	has	to	do	with	trade	

in	an	agreement	



•  Existing procurement-related training 
programs

138	

programs	

for	training	
	

that	are	
related	to		

procurement	

and	that	exist	



Avoid noun clumps


•  Helpful integrated municipal 
infrastructure asset management tool



Avoid	
unnecessary	
expletives	
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•  There is one person here today who 
has to leave early.

•  There is one person here today who 
has to leave early.

•  One person here today has to leave 
early.
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•  It is the Arctic countries that will be 
most affected by climate change.

•  It is the Arctic countries that will be 
most affected by climate change.

•  The Arctic countries will be most 
affected by climate change.
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Exercise!
 Page 35
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Oxymorons

•  Original copies
•  Exact estimate
•  Unbiased opinion
•  Extensive briefing





Redundancies, etc.

•  Advance planning
•  Foreign imports
•  Doctorate degree
•  Skirt around
•  Few in number
•  Filled to capacity
•  Depreciated in value
•  SIN number, PIN number, HIV virus, ATM 
machine, NDP party





Persuasion	 3.4	



Persuasion
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Persuasion


•  Avoid long narratives: readers get lost.
•  Be aware of the difference between 
facts and the interpretation of those 
facts.
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Persuasion requires three 
elements: 
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CREDIBILITY	(APPEAL	
TO	ETHOS)	

TANGIBLE	EVIDENCE	
(APPEAL	TO	LOGOS)	

APPEAL	TO	EMOTION	
(APPEAL	TO	PATHOS)	



Credibility


•  Credibility comes from experience, 
truth, trust and goodwill.

•  Credibility builds upon credibility.
•  To be credible, you have to

– be believable
– present clear ideas
– not contradict yourself, either in words or 
behaviour
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Tangible evidence


•  Claims are backed up with supporting 
evidence

•  Appeals to the rationality of the 
readers
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Appeal to emotions


•  Addresses the mood of the readers
•  Helps the reader identify and 
sympathize with an issue
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Strengthening Ideas


•  Present solid arguments that build on 
your main idea

•  Make them accessible using plain 
language

•  Provide examples



Finishing Your 
Document


Part 3



Revise	for	Readability	
and	Strength	

Step	4	





Editing for conciseness




How long?


•  Long enough 
to cover 
everything 
important

•  Short enough 
to keep me 
interested 



Exercise!


•  Page 40



Revise for readability


•  Use white space effectively
•  Left-justify text
•  Use margins effectively



Use white space effectively

•  This? •  Or this?
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Slide	courtesy	of	Michelle	Boulton,		
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Letter case 
OUR EYES RECOGNIZE WORDS BY THEIR 
SHAPE AS WELL AS BY THE LETTERS THEY 
INCLUDE. TEXT SET IN ALL CAPS IS THE LEAST 
LEGIBLE BECAUSE EACH WORD IS THE SAME 
SHAPE. 

Another Problem Occurs When You Use Title Case 
In Sentences. Title Case Is A Mixture Of Upper And 
Lower Case And Is Suitable For Titles Only 
Because It Is Too Hard To Read.	

Letter case 
OUR EYES RECOGNIZE WORDS BY THEIR 
SHAPE AS WELL AS BY THE LETTERS THEY 
INCLUDE. TEXT SET IN ALL CAPS IS THE LEAST 
LEGIBLE BECAUSE EACH WORD IS THE SAME 
SHAPE. 

Another Problem Occurs When You Use Title Case 
In Sentences. Title Case Is A Mixture Of Upper And 
Lower Case And Is Suitable For Titles Only 
Because It Is Too Hard To Read.	
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Readability



•  Is the tone convincing?
•  Have I expressed myself clearly?
•  Is there any ambiguity?
•  Is the length appropriate
•  Does the content match the reader’s 

level of knowledge?
•  Have I said everything as concisely as 

possible?
167	



Edit	for	
Correctness	

Step	5	



Edit for Correctness


•  Typeface changes
•  Twins (brackets, quotation marks, em 
dashes)

•  Strings of small words
•  Proper nouns
•  Correct spelling and punctuations 



 


Proofreading is not reading



To be a good proofreader…


you have to

�  turn off auto-correct
� s-l-o-w  d-o-w-n



So, what about Spell Check?


Heir to the Throne

Air to the Thrown



Spelling


Context matters: 

•  compliment/complement 

•  form/from 

•  files/flies 

•  public/pubic 
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Hone techniques for spotting 
errors




Errors are like grapes




Errors hide in little letters in the 
middle of long words


“the Conversation 
Council’s recycling 
record comes under 
fire”



•  Limited resources exist in the 
undeserved community.

•  Limited resources exist in the 
underserved community.



Always check the spelling of names!



Tips for Self-Editing


•  Print and proofread.
•  Read your work out loud.
•  Make more than one pass through the 
document

•  Use a ruler
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Moira White
Performance Management Consultants

moira@ubiquitext.ca 

www.ubiquitext.ca
www.editors.ca 


